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Open the schedule for this lesson  

1. On the toolbar, choose File.  

2. In the Files and Templates: Open and Save Options section, 
select Open Samples or Lessons.  The Open a Sample Chart dia-
log displays. 

3. Under Select a Folder below to Open, select Lessons.  The Les-
son schedules will display in the window to the right. 

4. Pick Lesson 11 Starter Schedule.mlj.  

5. Save the schedule to an accessible folder on your computer. 
Choose the File tab.  In the Files and Templates: Open and Save 
Options section, choose Save As….  In the menu that displays 
choose Chart.  Name, then save the schedule. 

Numbers can be shown along with a schedule.  These numbers can be contained in value categories called ValueSets (e.g. Manhours, 
Budget, and Costs) and then graphed on a DataGraphs, as well as totaled for each row (in columns).  

There are five different types of ValueSets possible with Milestones Professional.  In this lesson you will learn about Types 1, 2, and 3.  You 
will learn how to work with these ValueSet types, build a DataGraph and more. 

Up to 9 ValueSets can be added to a schedule.  They can be graphed on up to 3 DataGraphs, a maximum of 8 ValueSets per DataGraph.  

In this lesson you will learn how to: 

• Create a Type 1: Keyed-In Global Values ValueSet.  

• Create a Type 2: Sum of Values Keyed into a Task Row 
ValueSet.   

• Create a Type 3: Allocate Column Values Across a Time-
line ValueSet.  

• Enter the values for a ValueSet. 

• Set up DataGraphs which display the ValueSets. 

• Create a Values SmartColumn.   

• Enter values in the Values SmartColumn. 

Lesson 11 - Introduction to  
ValueSets and DataGraphs 

Schedule with DataGraph Generated from ValueSets 1,2, and 3 

Lesson 11 Starter Schedule 
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Create the Budget ValueSet as Type 1: Keyed-in Global Values   

First, create one Type 1 ValueSet.  These values are entered by specified time increments (daily, weekly, monthly, etc.) and 
do not relate to specific tasks.  Here, you will enter monthly Budget values for the whole project. 

1. Click the Tools tab. 

2. In the Graph Options section choose Set Up ValueSets.  The Create or Edit 
ValueSets dialog box displays. 

3. For the Set Alignment for ValueSets option choose Monthly as the time peri-
od to align the values. 

4. Click the first Create/Edit button to the left of 1: No Name Assigned …  The 
ValueSet Properties dialog displays.    

5. For ValueSet Name enter Budget.    

6. Under the Data Source tab, choose Type 1: Keyed-in Global Values as the ValueSet type. 

7. Click the Display/Edit Values... button.   The Edit Values dialog box displays.  

8. In the Edit Value dialog box enter the following val-
ues a monthly budget value in each cell under    
Value.   
February: 3000 
March: 4000 
April: 5500 
May: 5000 

9. Choose OK to return to the ValueSet Properties 
dialog box (keep this dialog box open for the next 
set of instructions.) 

 

The From date for row 1 is defined by the start date of this schedule (2/1/24).  The To date for row 1 is defined by alignment chosen 
in Step 3 (for this tutorial Monthly ). Thus, row 1 is February's budget, row 2 is March’s budget, and so on. The final date where a 
value can be entered is established by the end date of the schedule. If the end date is not the last day of a time increment selected a 
value can not be entered for the last time increment as seen in this tutorial. The last day of this schedule is 6/15/2024 therefore the 
last budget value that can be added is for May.  A June budget value can not be inserted because the entire month of June is not 
included in the date range of the schedule. 
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Create the Budget ValueSet as Type 1: Keyed-in Global Values cont’d 

10. Chose the Graphic Properties tab to set the ValueSet Display Properties and Graph Properties for Budget ValueSet. 
 
UNDER ValueSet Display Properties  

a. Check on Graph Values to have the Budget ValueSet 
values graph as bars, lines, or points in the DataGraph. 

b. Check on Values Represent Currency and the $ will 
display on all values for the Budget ValueSet in the  
DataGraph. 

c. Select 0 for Number of Decimals to Display.  All values 
for the Budget ValueSet will not show any decimal val-
ues. 

d. Check on Show Value Near Point. For this example the 
Budget ValueSet is going to be a point graph. For each 
month a point (represented by a symbol) will have the 
Budget value for that time increment displayed above 
the point (symbol). 

UNDER Graphic Properties  

a. Budget ValueSet values are going to be graphed as 
points.  Under Symbol for Point Graphs: select symbol 
4 green diamond with letter B.  The list of symbols 
available for points is a reflection of the toolbox. The 
green diamond was set up in the toolbox, see tutorial 
Lesson 4 for more information on setting up symbols in 
the toolbox.  
 
 
 

 
 
 

11. Click OK to return to the Create or Edit ValueSets dialog box 
(keep this dialog box open for the next set of instructions). 

Notice:  
Row 1. Budget. Contains 4 Values referencing  the 
values entered in step 8 on previous page. 
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Create the Cost ValueSet as Type 2: Sum of Values Keyed into Task Rows 

Next you will create a Type 2 ValueSet. These values are entered by specified time increments (this tutorial monthly) for a 
specific project task. Later, you will enter monthly Costs values for each of the project tasks. 

1. Click the Create/Edit button to the left of 2: No Name Assigned … to display 
the ValueSet Properties dialog  

2. For ValueSet Name enter Cost. 

3. Under the Data Source tab, choose Type 2: Sum of Values Keyed into Task Rows as the ValueSet type.      

4. Click the Graphic Properties tab to change the ValueSet Display Properties and Graph Properties . 

UNDER ValueSet Display Properties  

a. Check on Graph Values to have cause the Cost Val-
ueSet to be graphed. 

b. Check on Values Represent Currency.  The $ will 
display on all values for the Cost ValueSet in the  
DataGraph. 

c. Select 0 for Number of Decimals to Display.  No 
decimal places will be shown for values in the Cost 
ValueSet. 

d. Check on Show Values under Each Task Row. Be-
cause Cost is  a Type 2 ValueSet the values entered 
are associated with a task row.  The values can be 
displayed in their task row  by checking on this op-
tion. A Milestones message displays informing that 
the font used for these values is Symbol Text font To 
change choose Format |Default Text | Symbol Text. 

e. Check on Show Value Near Point. For this example 
the Cost ValueSet is going to be a point graph. For 
each month a point (represented by a selected sym-
bol) will have the Cost value for that time increment 
displayed. 

f. Check on Show value Below Point to have the Cost 
values display below the point (symbol). 

UNDER Graphic Properties  

a. Cost ValueSet values are going to be graphed as 
points.  Under Symbol for Point Graphs: select sym-
bol 3 red diamond with letter C.  The list of symbols 
available for points is a reflection of the toolbox. 
The red diamond that was set up in the toolbox, see 
tutorial Lesson 4 for more information on setting up 
symbols in the toolbox.  

5. Click OK to return to the Create or Edit ValueSets dialog box (keep this dialog box open for the next set of instructions). 

Notice:  
Row 1. Budget. Contains 4 Values.   
Row 2. Cost. Contains 0 Values. Values will be entered later. 
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Create the Manhours ValueSet as Type 3: Allocate Column Values Across Timeline 

Now, create a Type 3 ValueSet.  These values are taken from a Values SmartColumn,  evenly distributed across each task's 
Gantt bar, and graphed by time period in the DataGraph.  Here, the Manhours column will contain the values for this Man-
hours ValueSet. 

1. Click the third Create/Edit button to the left of 3: No Name Assigned … to reach 
the ValueSet Properties dialog box. 

6. Click the Graphic Properties tab to Set the ValueSet Display Properties and Graph Properties . 

UNDER ValueSet Display Properties  

a. Check on List Numeric Values above or Below Graph to have 
Manhours ValueSet values display in each time increment 
above the graph.  For values to display below graph select 
option when setting up the DataGraph. 

b. Check on Graph Values to have Manhours ValueSet values 
graph as bars, lines, or points in the DataGraph. 

c. Select 0 for Number of Decimals to Display.  All Values for the 
Cost ValueSet will not show any decimal values. 

UNDER Graphic Properties  

a. Manhour ValueSet values are going to be graphed as bars 
with a gradient from Silver to Black. Select the Line/Bar Color: 
Silver 

b. Select the Bar Pattern: solid which is the first option in the 
drop down 

c. Select the Solid Bar Target Color: Black 

d. Select the Solid Bar Effects: Fade to Bottom.  

7. Click OK to return to the Create or Edit ValueSets dialog box, where 
you should have these three ValueSets: Budget, Cost and Manhours 

8. Choose OK to return to the schedule.  You will not notice any change in the schedule. 

Row 1. Budget. Contains 4 Values.   
Row 2. Cost. Contains 0 Values. Values will be entered later. 
Row 3. Manhour. Contains 0 Values. Values will be entered later. 

2. For ValueSet Name enter Manhours. 

3. Under the Data Source tab, choose Type 3: Allocate Col-
umn Values Across Timeline as the ValueSet type.   

4. For Select Column scroll to 11. Manhours and select it. 

5. Check on Allocate to Current Date.  Values will only 
graph to the schedule’s current date. 
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Enter the Values for the "Costs" ValueSet 
The Costs ValueSet already exists, yet does not contain values. On a row-by-row basis, you will now enter those values. 

Enter the costs for the Research task row... 
1. Click the () Arrow tool in the toolbox. 

2. On the schedule, right-click the word Research, and from the right click menu choose Edit Val-
ueSet.  The Select ValueSet to Edit dialog box displays.  

3. Click the Edit button to the left of 2. Costs.   

4. The Edit Values dialog box appears.  Since Research takes place only in 
February and March enter 2000 for February and 1000 for March . 

5. Click OK, and OK again, to return to the schedule. You will see the values you 
entered in the Research task row however the graph will not appear yet. 

Enter the costs for Design... 

1. Right-click the word Design, from the right click menu choose  Edit 
ValueSet.  The Select ValueSet to Edit dialog displays.  

2. Click the Edit button to the left of 2. Costs. 

3. Since Design takes place only in March and April enter 2000 for 
March and 2000 for April. 

4. Click OK, and OK again, to return to the schedule. You will now 
see those values in the Design task row. 

Enter the costs for Prototype... 

1. Right-click the word Prototype, from the right click menu choose 
Edit ValueSet. The Select ValueSet to Edit dialog displays.  

2. Click the Edit button to the left of 2. Costs. 

3. Since Prototype takes place only in April and 
May, enter 1400 April and 1000 for May. 

4. Click OK, and OK again, to return to the schedule. 

Enter the costs for Testing... 

1. Right-click the word Testing, from the right click menu choose Edit 
ValueSet. The Select ValueSet to Edit dialog displays.  

2. Click the Edit button to the left of 2. Costs. 

3. Since Testing takes place only in March and April, there are no 
costs associated with other months. Therefore, 
enter 1500 for March and 2500 for April. 

4. Click OK, and OK again, to return to the sched-
ule.  You will see the values you entered in each 
task row however the graph will not appear yet. 

Choose F9 on the keyboard to refresh the 
Milestones schedule to show any values or 
words that are not fully visible. 
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Set up the DataGraphs that will display the ValueSets  

In the previous steps, you set up three ValueSets (Budget, Costs, and Manhours) and en-
tered the values for two of those ValueSets (Budget and Costs).  Next, you will set up two 
DataGraphs: The first will display Budget and Costs, and the second will display Manhours. 

DataGraph 1 

1. Select the Tools tab. 

2. In the Graph Options section choose Setup DataGraph.  The DataGraph Options dialog box displays with DatagGraph 1 
options showing. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

3. Select the Assign ValueSets to this Graph... button the Assign ValueSet to DataGraph dialog box comes up.   

4. Check on 1. Budget.  Contains 4 Values and 2.Cost. Contains 5 Values . 

5. Click OK to go back to the DatagGraph 1 options.  

6. Check on Show this Graph. 

7. For Graph Height enter 2.00. 

8. For Data Display Format choose Points. Values entered for budget and costs will show on the DataGraph as the symbols 
selected under the respective ValueSets Graphic Properties tab.  

9. Under Y axis you can select values for High Number, Increment and Low Number these values build the Y-axis  values of 
the DataGraph.  For this tutorial we will leave the values at zero allowing Milestones to automatically build the Y axis val-
ues.  Do check on Include Horizontal Gridlines . For Line Style select 18.  For Line Color select Silver. 

10.Check on Extend Chart Gridlines into DataGaph Area. Monthly vertical grid-
lines that are showing in the schedule area will also  show in the DataGraph.  
(Keep this dialog box open for the next set of instructions). 

All selections below the DataGraphs tabs bor-
der are generic settings for all 3 DataGraphs. 

Milestones can have a total of 
three DataGraphs containing up 
to 8 ValueSets. 
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Set up the DataGraphs that will display the ValueSets cont’d 

DataGraph 2 

1. Select the DataGraph 2 tab. All options will be available for selection for DataGraph 2. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 
 

2. Select the Assign ValueSets to this Graph... button.  The Assign ValueSet to DataGraph dialog box comes up.  

3. Check on 3. Manhours.  Contains 0 Values. 

4. Click OK to go back to the DatagGraph 2 options.  

5. Check on Show this Graph. 

6. For Graph Height enter 1.50. 

7. For Data Display Format choose Bars. Values entered for Manhours will show on the DataGraph as bars.  

8. Again leave the High Number, Increment and Low Number zero allowing Milestones to automatically build the Y axis 
values.  Do check on Include Horizontal Gridlines . For Line Style select 2.  For Line Color select Black. 

9. Under Background Color select light silver or a color of your choice. 

10.For Color Effects choose Fade 
to Bottom. 

11.Click OK to return to the sched-
ule. Budget and Cost DateGraph 
is generated.  Manhours Data-
Graph is generated however the 
values will not populate until 
the Manhours column is set up. 

Budget and Cost Points DataGraph 
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Enter values in the Values SmartColumn 

1. Click the (T) Text tool the toolbox. 

2. Click once in the Manhours column Research task row cell. 

3. Enter a value of 500.  

4. Select Enter or the down arrow key on your keyboard, to get to the next task row's Manhours cell. Notice, 
the DataGraph will build.   

5. Enter the following values: 
In Design cell enter 700 
In Prototype cell enter 200 
In Testing  cell enter 500 
When the last value is entered do not click enter or down arrow. Simply click with your mouse outside the 
schedule.  If you do select enter or the down arrow this will take you to a second page.  To get back to the 
first page choose the Edit tab. In the Delete section choose Current page. Below is the Manhours Data-
Graph populated with bars. 

Create a Values SmartColumn that contains user-entered values 

You will change the Manhours column to a Values SmartColumn, then enter values for that column. 

1. Click the () Arrow tool in the toolbox.  

2. Click the Manhours column heading.  The toolbar will change to the Selection tab with Current Object: Column Heading.   

3. Choose Switch to Column. 

4. In the Column Type and Format section, click the down arrow next to (none). 
From the drop down menu choose Values.  The Indicators for Values column dialog box displays. 

5. In the Indicators for Values column dialog box make no changes from the default options already chosen, just select OK 
to return to the schedule.  You will now see 0's in the Manhours Values SmartColumn. 

Manhours Values SmartColum and DataGraph  


